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Figure 1 Rapid Entry Procedure 

Internet and this catalog is known as the Reference Web Catalog. 
Once you have created your catalog , you can view and sort your titles and 
print various reports to list and summarize your collection. 

1.1     Features: 
• Coverage of the publication specifications, audio specifications, talent, 

subject matter including themes, disc mastering technical specifications, 
and the content of your collection. 

• Movies in Box Sets are cataloged individually. 
• Reference Catalog with over 43,000 DVDs  and 16,800 laser discs issued 

in the United States from 1979-2003. 
• Rapid Cataloging Wizard to quickly create a catalog of your discs without 

entering the data yourself. 
• UPC (Bar) Codes for most discs permit cataloging with a bar code reader 
• List of publishers and distributors with mailing addresses. 
• Compatible with Windows ‘98, Windows Me, Windows NT, Windows 

1     Overview 
Have you wanted to create a catalog of your DVD or laser disc collection? 
Have you wanted to build the catalog without the need to enter a lot of data? If 
your answer is yes then The DVD Register will meet these needs. 
Using the catalog number, the universal product code (UPC), or the title you 
can select from a reference catalog of all of the DVDs and laser discs published 
in the United States and then copy the matching titles to a personal catalog of 
your discs. In most cases you will not have to enter the data yourself. If you 
have a bar code reader connected to your PC, you can automate the inventory 
of your collection with the “Rapid Cataloging Wizard”. If you are just starting 
your collection you can create a “want list”. A copy of the reference catalog is 
installed on your PC and this is known as the local reference catalog. The DVD 
Register can also search a copy of the reference catalog that is located on the 
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2000., and Windows XP 
• Context sensitive help for most forms and procedures. 
• 20 standard reports to list and count your collection. Portable formats help 

you avoid purchasing duplicates and comprehensive formats help your 
friends select movies that are available in your home theater. 

• Create your own custom report format. 
• Create your own custom attributes for extra data you want to record. 
• Flexible searching, filtering, and sorting of records for both displays and re-

ports. 
• Multi-resolution forms to match the preferred resolution of your display 
• Context sensitive and dockable tool bars. 
• Export capability to permit you to use other database applications with your 

records. 
• Live Update keeps track of the reference catalog updates you have applied 

and automatically applies the updates that you need. 
• Download images of both front and back artwork with your personal catalog. 
2    Setup 
2.1     First Time Installation 
To setup the application, insert the CD-R in your drive. Normally the setup appli-
cation will auto-run. If not, then use the Run command in your Start menu to find 
the setup.exe file on the CD.  
You may find that the setup application will install some system files and then 
ask for a reboot.  You must restart your PC to continue with the setup process. 
After the reboot you will need to manually restart the setup application. The 
setup applications will then install the Access 2002 (a.k.a. XP) Runtime client. 
You must reboot after the Access 2002 runtime client has been installed.  
Setup will resume automatically after the reboot and will install the DVD Regis-
ter application. After setup completes, there will be short cuts installed in the 
Start Menu. Use the “DVD Register” short cut to start the application. 
If your are installing from the internet, then you will download a compressed file 
that must be unpacked before you can run the setup application. Move the com-
pressed file to a temporary directory. The install pack is a ZIP file. To unzip the 
file, you will need to use an unzip program such as WINZIP. Once the file is un-
packed, you should execute the setup.exe program. After the setup has success-
fully completed you can remove the temporary installation directory and all of 
the files that it contains.   
Note: The install pack  that can be downloaded from the Internet does not con-
tain the Microsoft Access 2002 runtime client, which is required for the DVD  
Register. In order to use the download, you  must have already installed the retail 
version  of Access 2002 on your PC. 

2.2     Upgrading from a Previous Release 
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To upgrade from a previous release of The DVD Register application you 
will need to install the new version of the software and then import your re-
cords from the older version of your personal catalog (the source) into the 
new release (the destination). Therefore you should not remove the previous 
version of the software before installing the new version. The new software 
will install by default in a different folder and will not overwrite the older ver-
sion. Do not install the new software in the same location as the old software. 
Once you have installed the new software use the following procedure to up-
grade your personal catalog: 
1. Start the application 
2. Select the “Upgrade Your Discs” subcommand under the “Import” com-

mand (File Menu). 
3. You will be presented with the Warning Screen. Select OK to proceed. 
4. In the File dialog box, use the navigation controls to go to the directory of 

the previous release. This will usually be C:\Program Files\Laser Disc 
Register 1.2x. Select the file “Laser Disc Register.mde” or “mdb” or 
“DVDreg.mde” or “mdb”. 

5. You will be presented with another warning screen, which gives you the 
opportunity to continue or cancel. The records from the source database 
always replace the records that are in the destination database. Any re-
cords that you have added to the destination database will be deleted by 
the import procedure and cannot be recovered.  

6. Click OK and the contents of the source database will be processed for 
import. If some records cannot be imported you will receive an error mes-
sage with the count of records that could not be processed. You will also 
have the opportunity to view an exception report of any titles that could 
not be upgraded. 

There is no way to undo an import once it has started. The only method to 
recover from an import is to restore the destination database from a back-up 
copy. The source database is not changed by the import procedure. 

2.3     Uninstalling the Application 
To remove the DVD Register application, open the Control Panel and then 
open the “Add/Remove Programs.” utility . Scroll down to “DVD Register 
1.23.x” and select the “Add/Remove…” command button.  Confirm that you 
want to remove the application. 
Next, using the “Add/Remove Programs” utility , scroll down to “Access 
2002 Runtime and select the “add/Remove…” command button. Confirm that 
you want to remove the application. 

3     Launching the Application 
The setup procedure will create a set of shortcuts in the Start Menu under Pro-
grams. Select the shortcut "Open DVD Register" to start the application. 
When you launch the application for the first time, it will request that you 
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provide a serial number. You will normally find the serial number printed on 
the cover of the CD-ROM. Enter the serial number into the text box provided 
and then click on the “OK” command button. 

4    Creating Your Inventory 
Each title in your personal catalog is displayed in a tabbed form. The first tab 
(Figure 2) contains the publication specifications of the disc. The second tab 
(Figure 3) lists the technical specification about the title. If the title is an LD, 

then Tab 2 will 
show a differ-
ent format for 
the technical 
specification. 
The third tab 
(not shown) 
provides room 
for a descrip-
tion of the sup-
p l e m e n t a r y 
features and for 
general re-
marks. 
You will notice 
that Tab 1 con-
tains a list of 
the movies or 
programs con-
tained on the 
disc or in the 
box set. To see 
more details 
about the 
movies or pro-
grams in your 
catalog you 
should use the 
“ M o v i e s 
Form” com-
mand (File 
Menu) to open 
the form show 
in Figure 4. 
You can use 

Figure 2 My Catalog Title Specifications Screen Example 

Figure 3 Example DVD Specifications Screen Example 
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the “My Cata-
log“ form or the 
“Movies or Pro-
grams“ form 
independently, 
or if you have a 
large enough 
screen, you can 
use the to-
gether. As you 
n a v i g a t e 
through “My 
Catalog“, the 
“Movies“ form 
will track the 
current record 
in the “My 

Catalog“ form. There are two sources of reference data of your personal cata-
log. One, known as the “Local Reference Catalog” is located on your PC and is 
installed with the software. Another known as the Reference Web Catalog” is 
located on the Internet. Either source can be used to construct your catalog. 

4.1     Entering Your Records with the Rapid Entry Procedure 
You can speed up the creation of your personal catalog by using the rapid entry 
wizard. You can copy a title from the reference catalog to your personal cata-
log by means of the UPC code, Catalog Number, or Title. A bar code scanner 
can speed up the process. Before entering your titles, you may want to clear out 
the sample titles that are included by default in the personal catalog. These re-
cords are for illustration purposes.  To delete these records, select one of the 
sample records and then click the delete button on the toolbar. Continue to 
click the delete button until all of the sample titles are removed.  Use the fol-
lowing procedure to rapidly create your personal catalog: 

1. Select Rapid Entry command  (Tools Menu).  
2. Select the attribute you want to use to search the reference catalog. The de-

fault is by title. 
3. Select the text box, and enter the search value. You start the search by 

pressing the Enter Key if the text box is selected. When you search by cata-
log and title, the search will select any records, i.e. wild card, that contains 
the information that you entered. You do not have to enter the complete 
catalog number or title.  The UPC must be an exact match. 

4. The reference titles that match your search criteria will be displayed in he 
upper grid.  

5. Once you find a reference title matching the disc in your collection, select 

Figure 4  Movies or Programs Form Screen Example 
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that record and then click the Add Record command button.  The title from 
the reference catalog will be copied to your personal catalog. When the 
copy is complete, the new record will appear in the lower datasheet which 
shows the titles in your personal catalog. 

You can speed up the process by checking the Auto Add on Single Matches 
check box.  When this box is checked and your search criteria generate a sin-
gle record from the reference catalog, that record will be copied automatically 
to your catalog. 
The catalog attribute is the most accurate way to locate records in the refer-
ence catalog. If the catalog number on the album cover includes a "-" or 
spaces, you should not enter these characters for your search. If you have a bar 
code scanner, the UPC attribute is the fastest way to create your personal cata-
log. However, there are 
some records in the ref-
erence catalog for 
which the UPC value is 
not known.  If you can-
not locate the reference 
record by means of the 
catalog or UPC code, 
then the title attribute is 
the robust way to locate 
the record, particularly 
if you use a unique 
fragment of the title. If 
all three methods do 
not produce a matching 
record, then the disc is 
not included in the ref-
erence catalog and you 
will need to enter the disc into your catalog manually. 
Set up your bar code reader, if you have one, to send a carriage return (enter 
key) after the data. This will eliminate the need to select the enter key after the 
scan. 
Make sure that before you make a scan with your bar code reader, that you 
have selected the text field next to the OK command button. You can tell that 
a field is selected by means of a flashing insertion point at the start of the 
field.  If the field is not selected, the data from your scan will not appear on 
the form. 

4.2     Entering Your Records with the Rapid Web Entry Proce-
dure 

The procedure for using the Rapid Web Entry is similar to the  Rapid Web and 
is recommended if you have a high speed connection to the Internet, otherwise 

Figure 5 Example Rapid Entry Screen 
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you are better off with the non-web procedure. Use the Tools>Rapid Web Entry 
command to open the search page and select the link: Search the Reference 
Catalog (Rapid Entry) and the screen shown in Figure 5 will appear. 
The form works in a similar fashion to the Rapid Entry form. To add a title to 
your personal catalog from the Reference Web Catalog select the “Add”  com-
mand button. One advantage of the Reference Web Catalog is that you will also 
download cover art. 
If you click on the thumb nail then you will be presented with a full size cover art 

art for titles that you have created from the local copy of the Reference Catalog 

5 Browsing the Reference Catalog 
You can use the Discs Grid to browse the all discs in the reference catalog. See 
Figure 6. By default the gird opens with the contents of “My Catalog” or “Mine”. 
You can select the radio button “All” to view the titles in the reference catalog. 
Filters can be applied to “All” titles. This approach is useful if you want to de-
velop a Want List for example of titles that star a specific actor or are the work of 
a specific director. You can apply a filter to the records shown in the grid view. 
First define the filter by selecting the desired values from the fields at the top of 
the form. You can select values in one or more fields. If you select multiple val-
ues then the filter criteria uses logical AND for each value. To apply the filter 
click the Filter Titles toggle button. If the “Filter Titles” toggle button is recessed, 
then a filter has been applied. Click the toggle button again to remove the filter. 

6    Live Update 
If you use the local copy of the reference catalog, you will want to keep the refer-

image of both the 
front and reverse 
covers. It is pos-
sible to search 
the Reference 
Web Catalog by 
publisher, per-
former, director, 
theme and other 
technical attrib-
utes. It is also 
possible to use 
the Rapid Web 
f o r m  t o 
download cover 

Figure 5 Example Rapid Web Entry Screen 
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ence catalog stored on your 
PC up to date with the latest 
titles that have been re-
leased. If you use the Refer-
ence Web Catalog, then you 
do not need to perform the 
update procedure. The Ref-
erence Web Catalog is al-
ways up to date. The Live 
Update feature automates 
the administration of refer-
ence catalog updates. Live 
update handles the follow-
ing tasks: 
• Login to the update site 
• Determine if any new 
updates are available 

• Download new updates 
• Apply the downloaded updates to the reference catalog 
In order to use the Live Update feature, you must have an active download sub-

scription and you must know your login and serial number. If you purchased 
the application or CD, then you would find the serial number marked on the 
CD cover. If you downloaded the application, then you would receive your 
serial number via e-mail. In order to receive a login to the download site, you 
must register on the download site. After your registration is processed, you 
will receive a login via e-mail. Once you have your login and serial number, 
you should enter then on the Help>About form. The Live Update feature will 
use the values entered on this form to login to the download site. 
In order for the Live Update feature to reach the download site you must have 
access to the Internet on your PC. Live Update will initially look for the de-

Figure 7 Example Live Update Screen 

Figure 6 Browsing the Reference Catalog 
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fault connection that you use to access the Internet. If it is a dial-up connection, 
then Live Update will initiate the dial-up script. If your dial-up connection is 
automatic including the dial-up access password, then Live Update will not 
require any manual intervention to reach the download site. If your dial-up 
connection requires a password that you enter each time that you initiate a con-
nection to the Internet, then you should initiate and establish the dial-up con-
nection before you start Live Update. 
Use the Tools>Live Update Command to start the live update. The Live Up-
date Status and Control Window will open as shown in Figure 6. 
Click the “Start Live Update” command button to initiate the Live Update. If 
you want to cancel a live update in progress, then click the “Cancel Update” 
command button. When you cancel an update, the updates process will finish 
the current step before stopping in order to restart later from a known point. 
The “Change Login and Password” command button will open the 
Help>About form, so that you can make a change to your login and password. 
You must close the Help>About form, before the revised login and password 
will be available to Live Update.  
Once Live Update starts, it will display progress messages in the form as well 
as update the progress bar. You can show/hide the detailed progress messages 
by setting/unsetting the check box. You can change the check box after Live 
Update has started but it may take a little longer for the change to take effect. 
Note: During the time that the update file is being downloaded you will see the 
animated pages move between the folders. 
Live Update keeps track of the updates that have been applied to the Reference 
Catalog, You can display a report of the updates that have been applied from 
the Tools>Reference Updates>Reference Updates command.  
The manual process of downloading and importing reference catalog updates 
can still be used. Live Update will recognize that an update has been applied 
manually and will look for later updates. 

8     Getting the Most out the Application 
Once you have completed the creation of your personal catalog you will want 
to print out reports, search or filter your catalog, and possibly update your cata-
log to include more information about the titles. For more instructions about 
these and other features open the “Help Contents” command under the Help 
Menu. 

9     Upgrades 
If you are a current download subscriber, you can download upgrades of the 
application from the internet at: http://www.orlofsky.com       
or http://www.dvd-register.com 
To contact the DVD Register customer support, send e-mail to: orlof-
sky@orlofsky.com 
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Release 1.23.8 Notes  - January 2006 
1. Your CD-R may contain new reference catalog updates. These new updates will be lo-

cated on the CD in the “Reference Catalog Updates” folder. The Readme.txt file will 
explain how to apply these updates. Alternatively you can download all new updates with 
the Tools>Live Update command. 

2. The CD is setup to autorun the setup procedure. Should the autorun not occur then the 
setup can be invoked manually by opening the setup.vbs file. The setup will occur in mul-
tiple phases. During the pre-setup phase you will be asked whether a retail version of 
Access 2000, 2002, or 2003 is installed on the PC. If yes, then the setup will launch the 
DVD Register application. If No, the setup will determine the version of Windows on the 
PC. If the version of Windows is 98, 98SE, ME, or NT, then the setup will install the 
Access 2000 runtime and then the DVD Register application. If the version of Windows 
is 2000 or XP, then the setup will install the Access 2003 runtime and then the DVD Reg-
ister application. If the version of Windows is 95 or cannot be determined, then the setup 
will abort and terminate. 

On Windows98 the setup will: 
1. Copy files and then request a reboot to update system files. 
2. Install the Access Runtime and then request a reboot. 
4. Install the DVD Register and no reboot will be requested 
On WindwsMe the setup will:  
1. Install the Access Runtime and then request a reboot 
2. Install the DVD Register and no reboot will be requested 
Win2000 or WinXP 
On Windows 2000 Professional the setup will. 
1. Install the Access Runtime and no reboot will be requested 
2. Install the DVD Register and no reboot will be requested. 

3. Several *.vbs files are provided to force certain setup procedures to occur and to bypass 
the OS detection logic. These can be used if the OS is known such as Win2003 Server but 
the pre-setup cannot recognize the OS correctly. The Access 2003 RT can be installed on 
Windows 2000 Service Pack 2 or later. The Access 2000 RT can be installed on Win-
dows98 or later. 

4. If the setup procedure fails by reporting that the setup has been invoked with the incorrect 
options and then stops prematurely and then says that a reboot is necessary then you may 
need to update your version of "Windows Installer". On the CD in the folder "Windows 
Installer 2.0" open the file InstMsiA.exe. This file will update your copy of Windows 
Installer to Release 2.0. Then restart setup and it will proceed. This can happen with Ver-
sions of Windows 98 that have not been updated with current applications that require the 
newer Windows Installer. 

10   Software License 
Use of The DVD Register software is subject to the terms of a software 
license. To read the software license, select the “About” command under the 
Help Menu and click on the command button on the “About” form to read 
the license. The software license is also printed on page 12 of this guide. 
Use of the reference data is limited to the purpose of cataloging a personal 
DVD or laser disc collection. Commercial use of the reference data is pro-
hibited. 
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The DVD Register—Software License Agreement 
This Software License Agreement is a legal agreement between you and the author of this software. The SOFTWARE in-
cludes computer software, the associated media, any printed materials, and any “online” or electronic documentation.  By 
installing, copying or otherwise using the SOFTWARE, you agree to be bound by the terms of this license.  If you do not agree 
to the terms of this license, you may not use the SOFTWARE, and you should remove the software from your computer. The 
SOFTWARE is protected by copyright laws and international copyright treaties, as well as other intellectual property laws and 
treaties.  The SOFTWARE is licensed, not sold. 
1           GRANT OF LICENSE 
This SOFTWARE LICENSE grants you the following rights: 
Software:  You may use one copy of the SOFTWARE on the COMPUTER. 
Back-up Copies: You may make back-up copies of the SOFTWARE.  You may use the back-up copies solely for archival 
purposes.  
2           DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS 
Limitations on Reverse Engineering, Decompilation and Disassembly:  You may not reverse engineer, decompile, or disas-
semble the SOFTWARE, except and only to the extent that such activity is expressly permitted by applicable law notwith-
standing this limitation. 
Separation of Components:  The SOFTWARE is licensed as a single product.  Its component parts may not be separated for 
use on more than one computer. 
Single COMPUTER:  The SOFTWARE is licensed with the COMPUTER as a single integrated product.  The SOFTWARE 
may only be used with a single COMPUTER. You may not use the software from multiple locations of a multi-user or net-
worked system at any time. You may not distribute copies of the software to others or electronically transfer the software from 
one computer to another over a network or otherwise. 
Rental:  You may not rent or lease the SOFTWARE.   
Software Transfer:  You may permanently transfer all of your rights under this SOFTWARE LICENSE, provided you retain no 
copies, you transfer all of the SOFTWARE (including all component parts, the media and printed materials), any upgrades, 
and the recipient agrees to the terms of this SOFTWARE LICENSE.  
Reference Database: You may use the reference data for personal non-commercial use. You may not use the reference data 
for purposes of the sale or marketing of Laser Discs or DVDs or other commercial uses.  
3           COPYRIGHT 
All title and copyrights in and to the SOFTWARE (including but not limited to any images, photographs, animations, video, 
audio, music, text and “applets,” incorporated into the SOFTWARE), the accompanying printed materials, and any copies of 
the SOFTWARE, are owned by the author. You may not copy the printed materials accompanying the SOFTWARE.  All rights 
not specifically granted under this SOFTWARE LICENSE are reserved by the author. 
4           DUAL-MEDIA SOFTWARE 
You may receive the SOFTWARE in more than one medium. Regardless of the type or size of medium you receive, you may 
use only one medium that is appropriate for the COMPUTER.  You may not use or install the other medium on another com-
puter.  You may not loan, rent, lease, or otherwise transfer the other medium to another user, except as part of the permanent 
transfer (as provided above) of the SOFTWARE. 
5           LIMITATION OF LIABILITY 
IN NO EVENT WILL THE AUTHOR BE LIABLE TO YOU FOR ANY SPECIAL DAMAGES, INCLUDING ANY LOST PROFITS, 
LOST SAVINGS OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES 
6           LIMITED WARRANTY 
THE AUTHOR DOES NOT AND CANNOT WARRANT THE PERFORMANCE OR RESULTS YOU MAY OBTAIN USING THE 
SOFTWARE. YOUR SOLE AND EXCLUSIVE REMEDY FOR 30 DAYS FROM DELIVERY OF THE SOFTWARE TO YOU, 
SHALL BE TO RETURN THE SOFTWARE, TERMINATE THIS LICENSE, AND YOUR  MONEY SHALL BE REFUNDED 
LESS SHIPPING AND HANDLING FEES. RETURN  POSTAGE IS YOUR RESPONSIBILITY. 
7           TERM 
This license is effective until June 1, 2050 unless terminated earlier. You may terminate the license at any time by destroying 
the SOFTWARE (including the related documentation) together with all copies and modification in any form. The author will 
have the right top terminate your license immediately if you fail to comply with any term or condition of the Agreement. Upon 
any termination, including termination by you, you must destroy the SOFTWARE (including the related documentation) to-
gether with all copies or modifications in any form. 
8           GENERAL 
You acknowledge that you have read this Agreement, understand it, and that by using the software you agree to be bound by 
the terms and conditions set forth in this Agreement. 

June 2000 


